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The Basics

Section 1 The Basics

By he End Of his Section You Will Be Able To Identify

•	 Title Bar

•	 Ribbons

•	 he Access window

•	 Ask a Question

Guide Information

Introduction

Access 2010 is a powerful Database application that allows users to produce tables, forms, queries and reports within 

a datbase it can also contain calculations, graphs, pictures and iles.. access to web data and sharepoint information is 

available to be built in to the database an extemely powerful database application.

All graphics related to Microsot in this book is in compliance with Microsot guidelines and thus permitted by Microsot.

How To Use This Guide

his manual should be used as a point of reference following attendance of the introductory level Access 2010 training 

course. It covers all the topics taught and aims to act as a support aid for any tasks carried out by the user ater the course.

he manual is divided into sections, each section covering an aspect of the introductory course. he table of contents lists 

the page numbers of each section and the table of igures indicates the pages containing tables and diagrams. 

Objectives

Sections begin with a list of objectives each with its own check box so that you can mark of those topics that you are 

familiar with following the training.

Instructions

hose who have already used a database before may not need to read explanations on what each command does, but 

would rather skip straight to the instructions to ind out how to do it. Look out for the arrow icon which precedes a list 

of instructions. 

Appendices

he Appendices list the Ribbons mentioned within the manual with a breakdown of their functions and tables of shortcut 

keys.
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Keyboard

Keys are referred to throughout the manual in the following way:

ENTER – Denotes the return or enter key, DELETE – denotes the Delete key and so on.

Where a command requires two keys to be pressed, the manual displays this as follows:

CTRL + [P] – this means press the letter “p” while holding down the Control key.

Commands

When a command is referred to in the manual, the following distinctions have been made:

When Ribbon commands are referred to, the manual will refer you to the Ribbon – 

E.G. “Choose HOME from the Ribbons and then B for bold”.

When dialogue box options are referred to, the following style has been used for the text – 

E.G.“In the PAGE RANGE section of the PRINTdialogue, click the CURRENT PAGE option”

Dialogue box buttons are Emboldened – “Click OK to close the PRINTdialogue and launch the print.”

Notes

Within each section, any items that need further explanation or Points for extra attention devoted to them are denoted 

by shading. For example:

“Access will not let you close a ile that you have not already saved changes to without prompting you to save.”

OR

“Access will not let you close a ile that you have not already saved changes to without prompting you to save.”

Tips

At the end of each section there is a page for you to make notes on and a “Useful Information” heading where you 

will ind tips and tricks relating to the topics described within the section.
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The Access Screen

WINDOW BORDER he box that surrounds the Access screen when it is not maximised is called the window border. 

When the mouse is over the border, the pointer changes from a single to a double-headed arrow – clicking and dragging 

with this shape allows the window to be resized.

TITLE BAR he coloured bar that appears at the top of the Access window. he title bar tells you which application 

you are using and if the document you are in is maximised, it will also contain the name of the document. If the Access 

window is not maximised, by positioning the mouse over the title bar and clicking and dragging, you can move the Access 

window to a new location on the screen.

MAxIMISE BUTTON When working in a document, the Access screen contains two windows, an application window 

and a document window. You can maximise both windows to capitalise on the space you have on-screen. If you would 

like the window that your Access application is in to ill up the whole screen, click the outermost maximise button. You 

may ind that the document you are in can still be bigger – click the inner maximise button to ill the remaining space 

within the Access application window.

MINIMISE BUTTON his button is very useful if you need to temporarily switch from Access into another application 

without closing Access down completely. Click the minimise button to shrink Access to an icon on the task bar; you will 

then be able to view other icons and applications you may wish to access. When you are inished and ready to continue, 

click the Access icon from the task bar to resume. he innermost minimise button will minimise the current document 

window.

RESTORE BUTTON his button only appears when a window is maximised. A maximised window has no border and 

you cannot see what is behind it. If you want to put the window back inside its border so that you can move and size it, 

click the restore button.

CLOSE BUTTON his button is used to close a window. If you click the close button for a document window you close 

the document. he last button will close the Access application.
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DIALOGUE BOx LAUNCHER this button launches dialogue boxes speciic to the part of the ribbon you see them the 

category will be named such as font, CLIPBOARD, etc

BACKSTAGE VIEW – FILE RIBBON is the start of Access and has many important commands and option. Such as 

Access settings, opening, saving, printing and closing iles. his will be looked into much further later in the manual.

Access Window Components

Access 2010 appears as displayedbelowwhena new database is created..here is a pane on the let to help all objects created 

within access and on the right the main work window to edit and create those objects such as tables and forms etc.

 ӹ To Activate a Button on the ribbon

MOUSE

1. Click the let mouse button on the required tool.

Dialogue Box
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To open a dialogue box use the DIALOGUE BOx LAUNCHER when the dialogue box is open, make a choice from the 

various options and click OK in the dialogue box. If you wish to change your mind and close the dialogue box with out 

making a choice then click on CANCEL. he dialogue box will close without any choice being applied. If you would like 

help while the dialogue box is open then click on the “?” in the top right hand corner this will bring up a help window 

that will display there levanttopics

Groups

Look at a group type on the ribbon such as font and in the bottom right hand corner of that group you may see a small 

box with a narrow, clicking this is an other method to callup a dialogue box, this time, directly from the ribbon. Many 

dialogue boxes may be more familiar if you have used Access before.

Toolbar 

here are only two tool bars with in the new version of Oice 2010 there is the quick access tool bar seen here next to 

the File tab, and there is the mini toolbar

Quick Access Toolbar

By default there are only three buttons on the quick access tool bar but these can be edited and other regularly used 

buttons can be placed there. Using the drop down menu next to the quick access tool bar will allow the customisation of 

this toolbar adding your most oten used commands.

Mini Tool bar

When ever text is selected within Access a small formatting tool bar will appear above the highlighted text it will 

disappear if the mouse cursor is move away from the tool bar and will reappear when the  mouse cursor is moved over 

the highlighted text again
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Status Bar

he Status bar, across the bottom of the screen, displays diferent information at diferent times. To the let is an indicator, 

which will display which view you are currently in, to the right are quick options to see which views are available and to 

change the view you are in E.G. Design
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view, form view or datasheet view..Also information about the status of Access, if anyparticular lock keys are enabled on 

your keyboard, which view is currently active, and more.

Task Pane

At ask pane is a window that collects commonly used actions in one place. he taskpaneen ables you to quickly 

createormodify a ile, perform a search, or view the clipboard.

It is a Web-style area  that you can either, dock along the right or let edge of the window or loat any where on the 

screen. It displays information, commands and controls for choosing options. Like links on a Webpage, the commands 

on a taskpane are highlighted in blue text, they are underlined when you move the mouse pointer over them, and your 

unthem with a single click.

At ask pane is displayed automatically when you perform certain tasks, for example when you choose clipart from the 

INSERT, Ribbon, to insert a picture

Ribbons Explained

One of the biggest changes in Access 2010 is the removal of menus. Instead of having a list of menu commands to choose 

from (including a number of options that are greyed out and not accessible), Access 2010 features a more intuitive control 

system of tabs. Each tab contains a certain group of commands relevant only to the tab. he commands are listed in the 

ribbon. 

Consider the HOME ribbon tab that is selected in the diagram above. Beneath the tab is a listing of all commands that 

are performed most oten on the currently selected object, contained in what Microsot refers to as the ‘ribbon’: 
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he ribbon was designed to allow access to all functionality of a tab at once. Also, the commands in the ribbon are only 

the commands that are available for use at the time. 

We will learn in this lesson how the ribbon works and some of the tools that are available. 

About Ribbons

here are two main types of ribbons: general (or command) and contextual. he general ribbons (and corresponding 

tabs) are always visible when you are viewing a database ile in Access: 

Command Tabs

Along the top of the window are the command tabs: 

In the past, the Oice package made use of menus that contained a listing of commands. At their core, the command 

tabs are essentially the same thing as menus but with a few big changes. For starters, the grouping of commands in tabs 

is much more intuitive. he commands listed under each tab are also the only commands that are applicable to your 

current view of the database. 

Access 2010 takes this one step further with the addition of contextual tabs. he tab labelled Fields and Table are a subset 

of the table toolsn and appears only when you have selected a table in Datasheet view. hese tabs will contain even more 

speciic commands that can be used on a table being viewed and will only be visible when a table is being viewed. 

he command tabs listed here include many of the most common commands you will perform in Access. he Home ribbon 

contains the majority of the most common tasks including the ability to switch views, formatting, and iltering of data. If 

you want to make a new database object, click the Create tab and select the object you want to make. he External Data 

command tab gives you all the lexibility to import and export data to and from your database, computer, and network. 

he Database Tools tab gives you the ability to manage the data in your database, create macros, and view relationships. 

Contextual Tabs

Contextual tabs appear only when a certain type of database object is selected (or brought into context). For example, if 

you are looking at a table in datasheet view, a contextual tab will appear showing you the commands you can perform on 

the table while only in datasheet view: 
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When using a command in the ribbon, simply click it with your mouse. he command will be performed, or the appropriate 

tool or dialogue box will appear to help you perform the task. If you are unsure what a certain command does, point to 

it, but do not click it. 

Tips

Ater a quick moment a description will appear. his is true for most of the commands: 

“The perfect start 

of a successful, 

international career.”

CLICK HERE 
to discover why both socially 

and academically the University 

of Groningen is one of the best 

places for a student to be 

www.rug.nl/feb/education

Excellent Economics and Business programmes at:

http://bookboon.com/
http://bookboon.com/count/advert/5e8cd819-4ddd-4941-a6bb-a16900eac393


Download free eBooks at bookboon.com

Access 2010: Part I

18 

The Basics

Navigation Pane

On the let side of the Access window is the Navigation Pane. It is always visible on the let side of the screen, but can be 

expanded ( ) or shrunk ( ) by clicking the double arrows. he Navigation Pane allows quick and easy access to any 

of the database objects.

Click the pull-down arrow beside the Navigation Pane title ( ) to show a list of all object categories: 

Object Tabs

In previous versions of Access, any open database object was opened in its own window and designed to ‘loat’ inside the 

Access Screen. When several database objects were open at once, it was diicult to navigate through all of the windows 

easily. Access 2010 has solved that problem by using tabs: 

Simply click any of the tabs visible on the top to show the database object. Opening many database objects will create let 

and right facing arrows (  and ); click on the arrow to scroll that direction through the open database objects. If you 

want to close an object you are no longer using, click the Close button ( ) located beside the tabs. 

About Smart Tags

Smart Tags, irst introduced in Microsot Oice XP, make it easier for you to complete some of the most common tasks 

in Access 2010 and provide you with more control over automatic features. 

You do not have to complete any additional steps to make the Smart Tags appear or disappear in Access. he Paste Options, 

AutoCorrect Options and AutoFit smart tags appear automatically to allow you to quickly choose actions and remain 

in place until you begin another action. For example, when you complete a paste operation, the Paste Options smart tag 

(below) remains in place alongside your text until you begin typing new text.

A “smart tag” is a type of button in Microsot Access 2010 that appears ater certain actions, such as an automatic text 

correction or a copy-and-paste, have taken place. he button has a menu of options that help you control the result of 

the action. For instance, if Access automatically capitalizes the irst letter of a word, but you want the word lowercased in 

this instance, you can click the “undo capitalization” option on the button menu to reverse the action.
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Access includes several of these smart tag buttons. hey function similarly but their look can vary and each has a speciic 

purpose.

Auto correct Options Smart Tag

he AutoCorrect Options Smart Tag appears ater an automatic correction or change, such as a lowercased letter that’s 

changed to a capital or a network path that’s converted to a hyperlink. he Smart Tag shows as a small, blue box when 

you rest the mouse pointer near text that was changed; it then becomes a button icon which, when you point to it and 

click it, displays a menu. If you don’t want the correction, use the options on the menu to undo it; turn of this type of 

correction completely; or connect to the AutoCorrect dialogue box to adjust settings.

Paste Options Smart Tag

he Paste Options Smart Tag gives you greater control and lexibility in choosing the format for a pasted item. he Smart 

Tag appears just below a pasted item, such as text, a table, or a slide, with options for formatting. For example, if you 

copy and paste a slide and insert it ater a slide that uses a diferent design template, you can choose to retain the original 

design for the slide or let the pasted slide assume the design of the slide it now follows.

Autoit Options Smart Tag

he AutoFit Options Smart Tag appears when Access resizes text you’re typing to make it it the current placeholder. If 

you don’t want the text to be resized, you can select options on the Smart Tag menu to undo the resizing or to connect 

to the AutoCorrect dialogue box to turn AutoFit settings of. Also, for single-column layouts, you can change to a two-

column layout, start a new slide to accommodate the text, or split the text between two slides. 

Automatic Layout Options Smart Tag
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he Automatic Layout Options Smart Tag appears ater you insert an item, such as a picture, diagram, chart, or table, that 

changes the initial layout of the slide. To accommodate the added item, Access will automatically adjust the slide layout. 

If you want, use the options to undo the automatic layout or turn it of completely. 

New Features In Access 2010

If you are familiar with previous versions of Access, there are a large number of new features and a completely new 

interface in Access 2010. If you have never used Access before, don’t worry – you will quickly become very familiar with 

these commands as time goes on! 

New Interface Design

Commands hidden in four diferent menu layers are a thing of the past with Access 2010.). Commands are now organized 

using a new action tab scheme. Under each tab are the commands relevant to the action described on the tab. his 

command set is referred to as the ‘ribbon.’ Finally, Access 2010 features contextual tabs showing data that is relevant only 

to the current object you are working on. We will explore the new interface in more detail later.
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New Template Categories

Access 2010 features eleven new templates, each with their own deined tables, forms, reports, queries, and relationships. 

hey are designed to let you start working right away, but are also completely customizable.

More Intuitive Sorting and Filtering

Access 2010 lets you pick from several predeined sorting methods with just a couple of clicks. Access also features a 

contextual quick sorting method using plain language. For example, if you have a column of numbers, Access can sort 

them Smallest to Largest. If you have a column of dates, Access can sort them from Oldest to Newest.

New Layout View

When working with forms and reports, Access 2010 features an in-between view called Layout View. It allows you to see 

a live form or report with real data in it, but also lets you adjust the position of certain elements in your form or report 

on the ly. You can also deine ‘mini layouts’ that allow you to move several controls as a group. Access still features the 

more in-depth Design view, used to ine tune every aspect of a control. 

Enhanced Tooltips 

When you hover your mouse above certain command icons, Access 2010 lists the command name, a short description 

of the command, and an example (if applicable). (Tooltips in previous Oice programs listed only the command name.) 

Automatic Calendar 

When entering information into a Date ield, a small icon will appear allowing you to choose a date from a small calendar. 

his eliminates the need to enter a date as 03/22/2010 – just open the calendar and pick the date! 

Rich Text in Memo Fields 

If a table makes use of a memo ield, data can now be stored as something other than plain text. Using an HTML-based 

text format, Access lets you automatically add colours, sizes, and formatting to the text in a memo ield. 

Quickly Create New Objects using the Insert Tab 

In previous versions of Access, you had to move and minimize windows to ind the Database window, pick the category 

of database object, and then choose to create a new object. With the Insert tab and ribbon, you can create a form based 

on a table with only two clicks (versus as many as a dozen clicks in the past). 

If you need a new table at any point, simply click Table on the Insert tab and start entering data. Access 2010 even lets you 

paste data directly from a Microsot Excel spreadsheet. Data types and formatting will be found and preserved automatically. 

Total Row in Datasheet View 

Every table in Datasheet view features an automatic Total Row at the bottom. You can ind the sum, count, average, 

maximum, minimum, standard deviation, or variance using the Total Row. 
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Field Templates 

In the past, it was potentially a long and tedious task to mould a number data type into a usable ield for your organization. 

Now, you can simply click and drag a predeined ield from a list right into your table at any point. 

Field List Task Pane 

When creating a query in previous versions of Access, each table had to be inserted into Design view in order to use 

various ields. Now, all ields in all tables are visible in a list. Just drag and drop the ones you need. 

Split Forms 

A Split Form is new to Access 2010; it combines Datasheet and Form view together as one. he Datasheet view can be 

placed on the top, bottom, let, or right side of the Form. 

Multivalued Fields 

A single ield can contain multiple values in Access 2010. Imagine you have a product that falls into a few diferent 

categories. In previous versions of Access and other database management programs, this would have required a many-

to-many relationship to be deined. Access 2010 handles this complicated background relationship with only an extra 

click when designing a ield. 

Attachment Data Type 

If you want to e-mail a document to a co-worker or some pictures to family members, the iles would be sent as an 

attachment to the e-mail. Access 2010 features a similar attachment data type that can hold documents, charts, sound 

iles, binary iles, or any other type of ile. Attachments are also automatically compressed when necessary to reduce the 

overall size of the database ile. 

Alternating Background Colour 

Datasheet view, reports, and long forms now feature the ability to alternate the background colours of each row. Long 

lists of data become much easier to read! 

Navigation Pane 

he Navigation Pane is an ever-present feature on the let side of the Access window. It contains a listing of all objects 

currently contained in the database. he Navigation Pane can also be collapsed to make more room in the window. 

Embedded Macros 

hough macros go beyond the scope of this manual, macros in Access 2010 are stored inside a database object instead of 

being a separate object. his makes these macros much safer to use. 
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Newly Designed Help 

Oice 2010 makes wide use of Oice Online, a resource on the Internet to ind help on a certain topic. Access 2010 also 

has diferent help levels; if you are an end-user rather than a developer who makes database code, you can tailor the help 

ile to search only the more basic topics. 

Increased and Enhanced Connectivity 

One of the goals of Oice 2010 was to create a centralized location where members of your organization can meet and 

share data over the Internet. hough many of these features are more advanced topics of Access not covered in this manual, 

Access features a huge variety of SharePoint services. Access lets you: 

Collect data from Microsot Outlook 

Store and retrieve data on a SharePoint server 

Integrate with SharePoint Worklow services 

Retrieve data from linked SharePoint lists 

Store a SharePoint list oline for use away from your organization 

Create and save import or export operations if you perform the same online task multiple times 

Export Data to PDF or xPS 

You can export a form, report, or datasheet as a PDF (Portable Document Format) or XPS (XML Paper Speciication) to 

easily print, post, and e-mail regardless of the computer platform your intended recipient(s) are using. 

 

  

 

                . 
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New Report View 

Report view allows you to browse your report without having to print or preview it. You can also sort and ilter records 

on the ly. 

Enhanced Group, Sort, and Total Feature 

You can apply new grouping and sorting levels much easier with Access 2010. Grouping is done following a natural 

sentence structure; you simply ill in the blanks along the way. 

Additional Security Features 

hough many of the security features go beyond the scope of this manual, Access 2010 (and indeed the entire Oice 2010 

suite) features a number of security enhancements and SharePoint services. his functionality includes: 

Enhanced security by disabling macros and code only until needed 

Revision tracking to see who modiied what and when 

Permission setting to restrict data modiication 

Restore deleted data from the SharePoint Recycle Bin in case of accidental deletion 

Open forms and reports using SharePoint even if Access is not open on your computer 

Keep track of changes made to memo ields 

Access and Windows

he Microsot Oice packages were primarily designed to run in the Microsot Windows operating system. Further 

iterations of the Oice package have been ported for use in other operating systems, such as the Macintosh operating 

systems. Because the Oice package is designed to run in a particular environment, it is also capable of using some 

features of the operating system (as well as being limited by some of the operating system’s shortfalls!). In this lesson we 

will explore the operation of Access 2010 as a whole. 

Recovering Access

Despite the best eforts of network administrators, programmers, and home users, there will inevitably come the time 

where something will go wrong. Viruses, spyware, power outages, and equipment failures can cause havoc if you are 

unprepared. However, you do have some tools available to use if you get stuck while using Access. Much of the data 

manipulation done in Access is saved automatically as soon as a particular operation has completed. For example, when 

you add data to a table, it is saved in the table as soon as the cursor moves to another ield. 

he other manual operations that can be performed in Access, such as the development of macros, forms and reports, 

must be saved by the user. However, Access does have a general AutoSave feature that is used every 10 minutes to save 

any work that has been done. 
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Should Access itself seem unresponsive, there might be a number of causes. If your computer is experiencing heavy network 

traic or processor load, some operations regarding Access are placed in a priority queue. With the speed and capability 

of today’s computers, this delay will likely be minor. Nonetheless, the best irst option is to wait for a few moments. If you 

see no activity, try opening another program on your computer. If the other program does not start, then you computer 

is likely stuck in a processing loop somewhere. 

Task Manager

Pressing CTRL + ALT + DELETE in the Windows 2000/XP environment will open the Task Manager. Check the 

Applications tab. should you see (Not Responding) beside Access or some other program, highlight the program in the 

list and click End Task. If you don’t see any unresponsive programs, it may be a background process. Click the Processes 

tab. Scroll up and down through the list of processes. You see one program with a 99% CPU usage, that process is likely 

stuck. Highlight the process and click End Task. 

If you manage to close Access without having to restart your computer, Access will have saved a backup ile in the same 

folder as the original working ile. he backup ile will be named ilename_Backup. 

If worst comes to worst and you cannot shut down Windows or end a process, you must physically power of or restart 

your computer. 
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Starting Access On Windows Boot

Microsot Windows contains a special folder in which you can add a program shortcut to have that program start every 

time Windows starts. Your computer may already have certain programs that start when you computer starts, such as 

antivirus and instant messaging sotware. 

 ӹ To have Access 2010 start when your computer starts.

MOUSE

1. Locate the icon you use to start Microsot Access 2010 normally, such as in the Start Menu. 

2. Right click on the icon, point to Send To, and then click Desktop: 

3. Once the icon has been created, or if you already have an icon on your desktop, right-click the icon and 

select CUT: 
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4. Browse to the following folder on your computer:

C:\Documents and Settings\<Your User Name>\Start Menu\Programs\Startup

OR IN VISTA

C:\Users\<Your User Name>\AppData\Roaming\Microsot\Windows\Start Menu\Programs\Startup
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5. Paste the icon into the folder: 

6. Every time your computer starts, Access will start as well. You can do this for any program on your 

computer. 

But be careful – adding too many programs will signiicantly lengthen the time needed to boot your computer. Plus, if 

you want to use your computer for a presentation or something other than the programs in the Startup folder, you must 

irst wait for all of the programs to open before you can close them and free up system resources. 

Using the Quick Access Toolbar

In the previous lesson, we introduced the new layout changes to Access 2010. In this section, we will learn a little bit 

more about each part of the new interface and how it works. his lesson will focus on features and customization options 

available with the Quick Access toolbar, located in the upper let-hand corner of the screen: 
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About The Default Buttons

Access features three default commands in the Quick Access toolbar: 

Save

Saves the most recent changes to the current database ile.

Print

Opens the Print dialogue box allowing you to adjust diferent print settings. 

Undo 

he Undo command will revert most changes made in Access. For example, if you made a formatting change to a form 

that you were not happy with, click the Undo button to go back one command. 

here is a small pull-down arrow beside the Undo button; click this to see a listing of the last few tasks that were performed. 

Click any task in the list to undo all commands to that point. 

Adding Buttons

As you become more familiar with Access you might ind it handy to have another command quickly available for use. 

hough the command tabs and ribbon signiicantly reduce the number of clicks it takes to do something, you might 

want to have a particular command always available. Access allows you to add the command to the Quick Access toolbar. 

For example, some of us have diiculty with spelling. Fortunately, many programs (including Access) feature a spell 

checking feature. In Access 2010, the spell checking feature is located in the Records section of the Home command tab: 

 ӹ To add this command to the Quick Access toolbar, 

MOUSE

1. Right-click the Spelling command and click ‘ADD TO QUICK ACCESS TOOLBAR:’ 
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2. he command (denoted by the small ‘ABC’ icon) will be placed in the QUICK ACCESS toolbar: 

Removing Buttons

If you no longer use a certain command or your Quick Access toolbar is getting a bit too illed with icons, you can remove 

them easily at any time. 
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 ӹ To remove a button

MOUSE

3. Right-click on any icon you no longer use and click REMOVE FROM QUICK ACCESS TOOLBAR:

Customizing The Toolbar

As you gain familiarity with Access (and other Oice 2010 programs) you have the ability to customize how the Quick 

Access toolbar looks all at once versus having to add icons one by one. To do this, click the small pull-down arrow  

(  ) located on the far right of the Quick Access toolbar and click More Commands: 

Note that you can click any command listed here to add that command to the toolbar. he commands that are 

already checked are those on the toolbar; simply click them to remove them.

 ӹ To customise the toolbar

MOUSE

1. When you click MORE COMMANDS, the Customize dialogue box (found in the Access Options) appears: 
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his window gives you the ability to add any of the functionality from any command tab or contextual tab you like to 

the Quick Access toolbar. 

2. Click the pull-down arrow beside the CHOOSE COMMANDS FROM combo box: 
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3. he irst category (File Tab) is all commands accessible via the File Tab. he next seven tabs are the main 

command tabs, the majority of which are visible when working in Access. (Some command tabs might not 

be visible at the time, depending on what you are doing with your database.) he third section of options 

are all of the contextual tabs that appear only when you are working with a speciic database object he inal 

section deals with macro commands, other miscellaneous commands, and a listing of every command in 

Access. 

4. Pick a listing from a particular category in order to see the commands it contains. For example, imagine 

you are going to make heavy use of pictures and diagrams in a database form. To do this, you will need to 

import each picture one at a time. herefore, you may ind it easier to add the INSERT IMAGE icon to the 

Quick Access toolbar so it is always accessible. 

5. Select the FORM TOOLS - DESIGN option and then scroll down the list of options until you ind IMAGE: 
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6. Click the Image icon to highlight it and then click the ADD >>button located in the middle of the window: 

7. his will add the Image tool to the Quick Access toolbar list on the right-hand side of the window. By 

default, the command is inserted at the bottom of the list (under the Undo command). 

8. You can change the order of any icons in the list by selecting an item in the Quick Access toolbar list and 

then clicking the up and down buttons on the right side of the list. Simply click an item in the list you would 

like to move up or down and then click the corresponding directional button: 

9. Items listed top to bottom will be displayed from let to right in the Quick Access Toolbar. To remove an 

icon from the list, select the icon and click the Remove button in the middle of the window. 
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10. If at any point you want to return the Quick Access toolbar back to its original coniguration, click the 

RESET button: 

11. his will remove all icons except for the original three (Save, Print, and Undo). 
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